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ABSTRACT 

 

The development of technology has brought about changes in various aspects of human life, one of 

which is the entertainment media, namely video games. Video games are a common form of entertainment 

that typically follows certain rules, providing opportunities for achieving victory. Video games encompass 

various genres, one of which is RPG (Role-Playing Game), which usually emphasizes gameplay, story, and 

characters. The game "Tower of Eternity" was created using RPG Maker MV software version 1.6.2. The 

method used in the game's development is SDLC (System Development Life Cycle). The purpose of creating 

this game is for entertainment and to foster an interest in playing RPG genre games. The game has undergone 

testing in two stages: Functional testing and Device testing. Functional testing revealed that most of the 

buttons can be used effectively. Device testing on 5 devices, including a PC, Asus N551ZU laptop, Asus 

Vivobook X513EAN laptop, Asus VivoBook X421EAY laptop, and Toshiba Protege Z830 laptop, showed 

that 3 devices ran very well, 1 device ran reasonably well, and 1 device ran less efficiently. The required 

device specifications to run this game are AMD FX 7600P, 8GB RAM, and Radeon R9 M280x 4GB GDDR5. 
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ABSTRAK 

 

Perkembangan teknologi membawa dampak perubahan terhadap aspek kehidupan manusia, salah 

satu diantaranya adalah media hiburan yaitu video Game. Video Game merupakan sarana hiburan yang 

umumnya mengikuti aturan tertentu, sehingga terdapat peluang untuk mencapai kemenangan. Video Game 

memiliki banyak genre, salah satunya adalah RPG (Role-Playing Game) yang umumnya fokus pada alur 

permainan, cerita, dan karakter. Game Tower of Eternity dibangun menggunakan software RPG Maker MV 

versi 1.6.2. Metode yang digunakan dalam pembuatan Game adalah SDLC (System Development Life 

Cycle). Tujuan dari pembuatan Game ini adalah sebagai hiburan dan meningkatkan minat dalam memainkan 

game bergenre RPG. Game ini telah dilakukan pengujian melalui dua tahap yaitu pengujian Fungsional dan 

pengujian Perangkat. Pengujian Fungsional menunjukkan bahwa sebagian besar tombol dapat digunakan 

dengan baik. Pengujian terhadap 5 Perangkat yaitu PC, laptop Asus N551ZU, Laptop Asus Vivobook 

X513EAN, Laptop Asus VivoBook X421EAY, dan Laptop Toshiba Protege Z830 menunjukkan 3 perangkat 

berjalan sangat baik, 1 perangkat berjalan cukup baik, dan 1 perangkat berjalan kurang baik. Spesifikasi 

perangkat yang diperlukan dalam menjalankan game ini adalah AMD FX 7600P, 8GB RAM, dan Radeon 

R9 M280x4 GB GDDR5. 

 

Kata Kunci: Game, RPG Maker MV, RPG, SDLC 

 

 

1. PENDAHULUAN 

Perkembangan teknologi saat ini membawa dampak perubahan terhadap aspek kehidupan manusia, 

salah satu diantaranya adalah media hiburan yaitu video game. Game merupakan sarana hiburan yang 

umumnya dilakukan dengan mengikuti aturan tertentu, sehingga dalam permainan ini terdapat kemungkinan 

untuk mencapai kemenangan atau kekalahan [1]. 

Video game memiliki banyak genre, salah satunya adalah RPG atau Role-Playing Game dimana dalam 

permainannya, para pemain memerankan tokoh tertentu yang dihadapkan pada permasalahan tertentu dalam 
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membentuk suatu cerita. Gamer menjalankan sebuah misi yang terdapat dalam permainan, dan mengakhiri 

permainan tersebut dengan cara menyelesaikan semua misi yang ada [2]. 

Perangkat lunak yang dibutuhkan dalam pembuatan game dinamakan game engine. Game RPG Tower 

of Eternity merupakan game dua dimensi dengan genre Role-Playing Game (RPG), yang dibangun 

menggunakan game engine RPG Maker MV versi 1.6.2. Pemain pada game ini dapat meggunakan 4 karakter 

dalam 1 party dengan maksimum level karakter 50, yang hanya bisa dimainkan di Platform Desktop.   

Tujuan utama penelitian ini adalah membuat game “Tower of Eternity” dengan genre RPG yang dapat 

menghibur pemain dan meningkatkan minat dalam memainkan game bergenre RPG. 

 

2. TINJAUAN PUSTAKA 

Genre Game 

Menurut Mokhammad Ridoi, S.Si. [3] jenis game mungkin sangat banyak dan bervariasi, dari cara 

bermain, jumlah pemain di dalam game, media untuk memainkan game, jenis game berdasarkan tipe game 

yang biasa dimainkan di smartphone dan computer. Game dapat dikelompokkan kedalam beberapa jenis 

yaitu sebagai berikut: 

 

1. Action 

Game ini bergantung pada keterampilan teknis dan kecepatan tangan untuk menyelesaikan permainan. 

Dalam perkembangannya, permainan aksi sering digabungkan dengan permainan petualangan 

(adventure game) untuk menciptakan genre baru yang disebut permainan aksi petualangan (action-

adventure game). Jenis permainan yang mengutamakan keterampilan teknis dan kecepatan tangan ini 

juga menawarkan alur cerita yang menarik untuk diselesaikan. 

 

2. Fighting 

Game ini menempatkan pemain dalam situasi satu lawan satu dengan musuh yang memiliki beragam 

keahlian. Dikarenakan karakter lawan dikendalikan oleh komputer, ini menuntut pemain untuk 

menguasai banyak kontrol yang harus dihafal agar dapat bertarung secara efektif. 

 

3. Shooter 

Game ini dikonsepkan pemain dibuat tertantang dengan persenjataan yang dapat dipilih dan umumnya 

musuh yang disusun acak. Ada dua jenis game dalam shooter yaitu, FPS (First-Person Shooter) dan 

TPS (Third Person Shooter). 

 

4. Role Playing Game 

Game ini biasanya banyak mengandung unsur petualangan. Khusus yang megandung unsur peperangan, 

player memiliki banyak perlengkapan tambahan sebagai pelengkap petualangan. 

 

5. Real World Simulation 

Game ini meliputi permainan olahraga dan simulasi masalah kendaraan termasuk kendaraan militer. 

Games ini kebanyakan melibatkan masalah fisik dan taktik, tetapi tidak masalah eksplorasi, ekonomi 

dan konseptual. 

 

RPG Maker MV 

Game engine yang digunakan untuk menciptakan RPG 2 dimensi adalah RPG Maker. RPG Maker 

telah mengalami tujuh versi, antara lain Sim RPG Maker 95, RPG Maker 2000, RPG Maker 2003, RPG 

Maker XP, RPG Maker VX, RPG Maker VX Ace, dan RPG Maker MV. Versi terakhir yaitu RPG Maker 

MV, pengguna akan menemukan antarmuka yang lebih mudah karena berbasis GUI (Graphical User 

Interface), dan memiliki kualitas gambar yang lebih baik daripada versi sebelumnya [4]. 

 

3. METODE PENELITIAN 

Metode penelitian yang digunakan dalam penelitian ini adalah metode SDLC (System Development 

Life Cycle), dengan tahapan sesuai gambar 3.1.  
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Gambar 1. Tahapan System Development Life Cycle 

 

 

1. Perencanaan 

Tahap ini dilakukan perencanaan awal dalam membuat sebuah game. 

2. Analisis perangkat keras dan perangkat lunak. 

Tahap ini menentukan jenis perangkat keras dan perangkat lunak yang digunakan dalam proses 

pembuatan game “Tower of Eternity”. 

3. Perancangan dan Implementasi 

Tahap ini dilakukan pemodelan dalam bentuk perancangan dan implementasi game yaitu pembuatan 

struktur navigasi, karakter, map, dan lainnya. 

4. Uji Coba 

Tahap ini dilakukan ketika game sudah selesai dibuat, yaitu dengan melakukan pengujian dan 

percobaan game dengan berbagai perangkat. 

 

4. PEMBAHASAN 

1. Perencanaan 

Game “Tower of Eternity” merupakan game berbasis Dekstop yang dibuat dengan menggunakan 

game engine RPG MAKER MV. Game ini memiliki 3 Main Quest yang menceritakan perjalanan dari 

Karakter Utama yang mengembalikan keadaan kota Atlasdam dari monster-monster yang ada di dalam Tower 

of Eternity. Game ini memiliki beberapa rintangan seperti melawan Monster yang bervariasi, menyelesaikan 

Quest, membantu NPC dalam mencari item untuk melanjutkan Progress. 

Latar belakang cerita dari Game “Tower of Eternity” adalah bercerita 4 orang pahlawan hidup di kota 

Atlasdam yang di tugaskan untuk membasmi monster-monster di dalam Tower of Etnity dan mengembalikan 

keadaan kota Atlasdam. 

 

2.  Analisis Perangkat 

Perangkat keras dan perangkat lunak yang digunakan dalam membangun game “Tower of Eternity” 

adalah:  

• Prosessor Intel core i7 9700F 

• Memori 16 GB 

• Video Card NVIDIA Geforce RTX 2060 Super 

• RPG Maker MV versi 1.6.2. 

• Operating System Windows 10 Pro 

 

3. Perancangan dan Implementasi 

Perancangan game perlu dilakukan  untuk menggambarkan struktur game supaya terlihat jelas dan 

rapi, yang meliputi struktur navigasi, storyboard, dan pembuatan game. 

 

A. Struktur Navigasi Game 

Struktur Navigasi digunakan untuk memberikan gambaran alur dari suatu elemen yang akan digunakan 

dalam Game. Struktur navigasi yang digunakan dalam penelitian ini adalah struktur navigasi campuran yaitu 

Linier, dan Hirarki sesuai gambar 2. 
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Gambar 2. Struktur Navigasi Game 

 

B. Perancangan Storyboard 

Storyboard dari Game “Tower of Eternity” digambarkan pada tabel 1. 

1. Judul  : Tower of Eternity 

2. Deskripsi :  

Game ini termasuk Game RPG. Jenis game ini adalah RPG (Role-Playing Game). Pemain yang 

dimainkan adalah pemain berkelompok (Party-Based), yaitu Karakter utama, Hikari, Karen, Roger dan 

Loid. 

3. Cerita singkat :  

Empat pahlawan yang mencoba mengembalikan keadaan kota Atlasdam dari serangan para monster 

yang ada di dalam Tower of Eternity. dalam perjalanannya, ia harus menyelesaikan quest, membasmi 

semua monster, dan mengambil sub quest jika ingin memperkuat dirinya dan kelompoknya (party). 

 

Tabel 1. Storyboard Tower of Eternity 

No Scene Penjelasan 

1 Scene 1 : Menu Awal 

 

Scene ini berisikan tombol pilihan 

seperti tombol memulai mulai, 

lanjutkan, dan pengaturan.  

2 Scene 2 : Intro Scene ini berisi intro yang 

menjelaskan empat pahlawan yang 

akan mengembalikan keadaan kota 

Atlasdam dari monster-monster yang 

ada di dalam Tower of Eternity. 
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No Scene Penjelasan 

 
3 Scene 3 : Cutscene 

Rumah Karakter Utama 

 

 
 

 

Setelah intro pada game selesai, 

maka permainan akan berlanjut ke 

cutscene Rumah Karakter Utama. 

Dalam Scene ini, ada perbincangan 

antar empat karakter membicarakan 

misi pertama mereka yang akan 

diberikan oleh Guild Manager di 

Guild Hall. 

4 Scene 4 : Main Quest 1 

 
 

 
 

 

Setelah cutscene pada game selesai, 

player akan masuk ke dalam Guild 

Hall dan berbicara dengan Guild 

Manager untuk mengambil Main 

Quest 1, pada saat perbincangan 

Guild Manager akan memberikan 

beberapa persediaan potion untuk 

player, setelah itu Guild Manager 

akan menjelaskan Main Quest 1 ke 

player yang berisi tentang membasmi 

para monster yang ada di Tower 

Lantai 1. Jika player berhasil 

menyelesaikan Main Quest 1, player 

akan mendapatkan Weapon Set. 

Player dapat melanjutkan ke Main 

Quest 2. Selama permainan 

berlangsung , player dapat 

menyimpan permainan kapanpun, 

sehingga pada saat player 

meninggalkan permainan atau kalah 

dalam melawan monster, player 

dapat melanjutkan permainan dari 

titik save yang telah disimpan. 

5 Scene 5 : Game Over 

 

Pada scene ini, ketika player dalam 

menjalankan Main Quest mati karena 

kalah melawan monster, maka akan 

terjadi Game Over dan dibawa ke 

menu awal untuk memulai 

permainan dari save terakhir. 

6 Scene 6 : Main Quest 2 

 

Setelah menyelesaikan Main Quest 1, 

Guild Manager mendapatkan info 

untuk Main Quest 2 yang berisi 

membasmi para monster yang ada di 

Tower Lantai 2, monster-monster ini 

semakin kuat dan ganas jadi Guild 
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No Scene Penjelasan 

 
 

 

 

 

 

 

 

Manager menyarankan untuk tidak 

masuk secara gegabah dikarenakan 

Tower Lantai 2 sangat dekat dengan 

Ruangan Boss, Hikari dan teman 

temannya pun berfikir untuk 

meningkatkan Equipment mereka 

terlebih dahulu sebelum masuk ke 

Tower Lantai 2. Sebelum 

melanjutkan Main Quest 2 Guild 

Manager menyarankan player untuk 

beristirahat di dalam Inn agar HP dan 

MP pulih Kembali. Jika player 

berhasil menyelesaikan Main Quest 

2, player akan mendapatkan 50000 

Gold dan dapat  melanjutkan ke Main 

Quest 3. 

7 Scene 7 : Main Quest 3 

 

 
 

Setelah menyelesaikan Main Quest 2 

dan beristirahat di Inn, player akan 

Kembali ke Guild Hall dan akan 

mendapatkan Main Quest 3 yang 

berisi membasmi Boss monster 

bernama Beroiz, dari deskripsi para 

petualang sebelumnya monster ini 

berbentuk seperti Naga dan sangat 

berbahaya, Hikari dan teman 

temannya bergegas masuk ke dalam 

Tower tersebut dan langsung 

memasuki Ruangan Boss untuk 

membunuhnya, jika player berhasil 

menyelesaikan Main Quest 3, player 

akan mendapatkan 100000 Gold dan 

game Tower of Eternity Tamat. 

8 Scene 8 : Simpan 

Permainan 

 

Pada Scene ini player dapat 

menyimpan data permainan dimana 

saja saat membuka menu agar player 

dapat melanjutkan permainan pada 

posisi terakhir yang disimpan. 

 

C.     Pembuatan Game 

Proses pembuatan Game “Tower of Eternity” menggunakan software RPG Maker MV versi 1.6.2. 

dilakukan melalui 5 tahapan yaitu instalasi RPG Maker MV, pembuatan project, pembuatan Map, 

pembuatan Aktor, dan pembuatan NPC. 

 

Instalasi RPG Maker MV 

Software RPG Maker MV versi 1.6.2 bisa diunduh dari official website dan juga di steam. Jika ingin 

melakukan intsalasi dari steam, pertama buka steam lalu membeli aplikasinya, setelah membeli aplikasinya 

langsung bisa melakukan install dari steam. Setelah proses install selesai, klik tombol launch dan RPG 

Maker MV bisa dijalankan dan otomatis masuk ke lokasi tempat steam yang berada pada komputer. 
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Gamabar 3. Proses instalasi dari Steam 

 

Pembuatan Project 

Pembuatan project game dengan cara klik menu bar File > New Project, ketik Nama dan Game Tittle 

yang ingin dibuat, serta tentukan lokasi untuk data project kemudian OK. 

 
Gambar 4. New Project 

 
Gambar 5. Nama dan Lokasi Project 

 

Pembuatan Map 

Bagian ini merupakan tahap yang sangat penting dalam pembuatan sebuah game, karena map adalah 

hal yang akan dilihat sepanjang game dimainkan. Ketelitian dan keterampilan sangat diperlukan dalam 

membuat map agar memiliki visualisasi yang baik dan dapat merepresentasikan suasana dari cerita. Terdapat 

dua cara untuk membuat map, yaitu New dan Load. New digunakan untuk membuat map secara manual dan 

Load digunakan untuk membuka file map yang sudah disediakan oleh RPG Maker MV. 

 
Gambar 6. Membuat Map 

Ketika memilih New, akan muncul kotak dialog yang di dalamnya terdapat General Settings yang 

berisikan Nama untuk judul map. Display name untuk nama yang akan muncul saat masuk ke map tersebut. 

Tileset merupakan jenis tile yang digunakan untuk membuat map dengan berbagai pilihan. Overworld untuk 

membuat map berbentuk peta seperti ingin membuat peta dunia game. Outside untuk membuat map daerah 

luar seperti kota, desa, hutan. Inside untuk membuat map didalam suatu tempat seperti di dalam rumah, 

toko, kastil. Dungeon untuk membuat daerah khusus untuk tempat goa, menara monster dan lain – lain. 
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Gamar 7. Tampilan Kotak Dialog New Map 

 

Pembuatan Aktor 

Pembuatan karakter menggunakan Character Generator dengan cara klik Tools > Character 

Generator atau klik icon pada gambar 8. 

 

 
Gambar 8. Membubat Aktor 

Ketika memilih Character Generator, akan muncul tab pembuatan karkater secara detail seperti pada 

gambar 10 yang di dalamnya terdapat Randomize untuk membuat karakter secara acak. Face Image untuk 

membuat wajah karakter dan bisa mengubah ekspresi karakter seperti pada gambar 10. Walk Character  

untuk membuat model karakter berjalan. Damage Character untuk membuat model karakter yang mati atau 

kalah dari pertempuran. Battler untuk membuat model karakter yang sedang menyerang. 

 
Gambar 9. Proses Pembuatan Aktor 

 

 
Gambar 10. Pembuatan Face Image 

 

Klik Save Setting untuk menyimpan format karakter dan klik Walk Character. Damage Character, 

dan Battler untuk menyimpan format gambar yang berfungsi untuk ditambahkan ke database. Membuka 

Database dapat dilakukan dengan cara klik Tools > Database(F9) atau klik icon gear yang ditandai pada 
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gambar 11. Lalu klik bagian Face untuk Face Image. Character untuk Walk dan Damage Character dan [SV] 

Battler untuk Battler seperti yang terlihat di gambar 12. 

 

 
Gambar 11 Membuka Database 

 

 
Gambar 12 Database Aktor 

 

Pembuatan Non-Playable Character (NPC) 

Pembuatan NPC hampir sama dengan membuat Aktor yaitu menggunakan Character Generator. 

Perbedaanya ada mode tambahan, yaitu mode Event yang bisa digunakan untuk membuat berbagai macam 

bentuk yang diinginkan. Salah satunya untuk membuat NPC untuk digunakan didalam game tersebut. Dapat 

dilakukan dengan cara klik Mode > Event atau klik icon pada gambar 13 > Klik ke bagian yang mau 

dibuatkan NPC. 

 
Gambar 13 Mode Event 

 

 
Gambar 14 Setelah dilakukan Mode Event 

 

Tersedia beberapa gambar untuk ditampilkan ke dalam game, setelah klik ke bagian yang diinginkan 

kemudian akan muncul sebuah kotak dialog. Kemudian klik image > Select an Image sesuai keinginan 

seperti gambar 15. 

 

 
Gambar 15. Pemilihan NPC 
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Pembuatan Monster 

Pembuatan monster menggunakan database dengan cara klik Tools > Database (F9) > Enemies. 

Ketika sudah membuka akan muncul tab pembuatan monster seperti gambar 16. Di dalamnya, terdapat 

Change Maximum untuk mengubah jumlah monster yang dibuat. General settings terdapat nama monster, 

status monster yang dapat di ubah sesuai keinginan dan image yang sudah tersedia beberapa gambar untuk 

di tampilkan ke dalam game. Reward untuk memberikan EXP (Experience Point) dan Gold. Drop Items 

untuk memberikan item Ketika player membunuh monster tersebut, dan Action Patterns untuk mengatur 

presentase monster menyerang. 

 
Gambar 16. Database Monster 

Ekspor Game 

Setelah semua alur game selesai, selanjutnya lakukan ekspor game dengan klik file > Deployment. 

 
Gambar 17. Deployment 

Dalam Dialog Deployment, bagian Platform untuk memilih Platform yang diinginkan untuk game 

tersebut. Option “Exclude Unused Files” untuk membuang file-file yang tidak diinginkan dalam proses 

game (namun tidak di rekomendasikan karena dapat membuat sebagian file penting hilang). Ecryption untuk 

mengamankan file agar tidak bisa diubah oleh orang lain, dan yang terakhir Output Location untuk memilih 

lokasi tempat aplikasi game yang ingin di Eksport. 

 
Gambar 18 Dialog Deployment 

 

D. Implementasi 

Pada tahap ini dilakukan implementasi game Tower of Eternity pada perangkat Desktop. 

1. Menu Awal 

Ketika player membuka game maka akan menampilkan screen menu awal. 



 
 
 
 

 
 JURNAL JTS Vol 2 No. 3 Oktober 2023 – pISSN: 2828-7002, eISSN: 2828-6871, Page 01-16 

11 

 

 
Gambar 19. Implementasi Menu Awal 

 

2.  Pengaturan 

Jika player memilih tombol “Pengaturan”, maka akan menampilkan menu pengaturan. 

 
Gambar 20. Implementasi Tampilan Pengaturan 

 

3.  Lanjutkan 

Jika player memilih tombol “Lanjutkan”, maka akan menampilkan menu lanjutkan. 

 
Gambar 21. Implementasi Tampilan Lanjutkan 

4. Intro 

Jika player memilih tombol “Mulai” maka akan masuk ke game. 

 
Gambar 22. Implementasi Tampilan Intro 

5. Simpan 

Jika player ingin menyimpan progress permainan maka akan muncul tampilan simpan. 
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Gambar 23. Implementasi Tampilan Simpan 

 

6. Tamat 

Jika player berhasil melawan Monster terakhir/Boss, maka akan masuk pada tampilan tamat . 

 

 
Gambar 24. Implementasi Tampilan Tamat 

 

4.  Uji Coba 

Tahap terakhir dalam pembuatan Game adalah uji coba Game di berbagai perangkat keras dengan 

tujuan mengetahui apakah game tersebut berjalan dengan baik atau tidak. Pengujian dilakukan dalam dua 

tahap, yaitu Pengujian Fungsional dan pengujian perangkat. 

A. Pengujian Fungsional 

Pada tahap ini dilakukan Pengujian Fungsional pada setiap tombol dalam game Tower of Eternity 

apakah tombol berfungsi dengan baik atau tidak. 

 

Tabel 2. Pengujian Fungsional 
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Berdasarkan dari hasil uji coba fungsional mendapatkan hasil bahwa 22 tombol dapat berfungsi dengan 

baik. 

 

B. Pengujian Perangkat 

Pada tahap ini dilakukan uji coba pada beberapa perangkat untuk memastikan apakah game dapat 

dimainkan pada spesifikasi tinggi dan rendah. Pengujian ini memiliki tujuan untuk mencari spesifikasi yang 

cocok untuk memainkan game Tower of Eternity. 

 

Tabel 3. Pengujian Perangkat 
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5. KESIMPULAN 

Game Tower of Eternity dengan RPG Maker MV ini telah berhasil dibuat dan diuji dari setiap 

fungsi tombol maupun menghibur pemain dengan cerita yang diberikan. Berdasarkan hasil pengujian 

permainan, dapat disimpulkan bahwa 22 tombol dapat berjalan dengan baik. Uji coba terhadap beberapa 

perangkat, dihasilkan ada beberapa laptop yang tidak berjalan dengan baik, tapi masih bisa menjalankan 

game tersebut walaupun tidak sebaik perangkat yang lain. Spesifikasi menjalankan game berdasarkan 

uji perangkat, dibutuhkan spesifikasi berupa AMD FX 7600P, 8GB RAM, dan Graphic Card Radeon R9 

M280x 4 GB GDDR5 untuk performa yang sangat baik. 
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